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SIMATIC S7 3964(R)/RK512 Driver

Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

& System Configuration” (page 3)

2 Selection of External Device
Select a model (series) of External Device
to be connected and connection method.

v

3 Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

\

4 || Setup ltems

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro EX or in offline mode.

\

5 || Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

4

Operation

&~ "2 Selection of External Device" (page 7)

& 3 Example of Communication Setting" (page
8)

&y Setup Items" (page 20)

5~ 5 Cable Diagram" (page 25)
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1 System Configuration

SIMATIC S7 3964(R)/RK512 Driver

The system configuration in the case when the External Device of Siemens AG and the Display are connected is

shown.

Series

CPU Module

Link I/F

SIO Type

Setting Example

Cable Diagram

SIMATIC
S7-300 Series

CPU312IFM
CPU313
CPU314
CPU314IFM
CPU315
CPU315-2 DP
CPU316
CPU316-2 DP
CPU318-2

CP341
(RS232C)

RS232C

Setting Example 1
(page 8)

Cable Diagram 1
(page 25)

CP341 (RS422/
485)

RS422/485
(4wire)

Setting Example 2
(page 11)

Cable Diagram 2
(page 27)

SIMATIC
S7-400 Series

CPU412-1
CPU412-2 DP
CPU413-1
CPU413-2 DP
CPU414-1
CPU414-2 DP
CPU414-3 DP
CPU416-1
CPU416-2 DP
CPU416-3 DP
CPU417-4

CP441-2
+ IF963-RS232

RS232C

Setting Example 3
(page 14)

Cable Diagram 1
(page 25)

CP441-2
+1F963-X27

RS422/485
(4wire)

Setting Example 4
(page 17)

Cable Diagram 2
(page 27)

NOTE | ¢ Set the execution time of the logic functions in the Display to "100 ms" or less. If the longer time is
set, an error may occur in the communication with the external device.
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m |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

PFXPL2B1-4)

Usable port
Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)

coM1™!', comz,
PS-20008 coM3™!, com4 i i
PS-3450A, PS-3451A, 10 . 1
PS3000-BA, PS3001-8p | COMI, COM2 COM2 CoM2
PS-3650A (T41 model), -
PS-3651A (T41 model) CoMI ) )
PS-3650A (T42 model), *1%) *1%) *]%)
PS-3631A (T42 model) coM1™1*2, com2 COMI COMI
PS-3700A (Pentium®4-M) | COM1"!, com2™!, 0 )
PS-3710A COM3"?, COM4 COM3 COM3
PS-3711A coM1™!, com2™ com2™ coMm2™
PS4000"3 COM1, COM2 - -

coM1*"2, com2™, 1% 1%
PL3000 COMS3, COM4 COMI COMI
PE-4000B Atom N270 COM1, COM2 - -

COM3™ , CcoM4™, | coM3™, comM4™,

PE-4000B Atom N2600 COM1, COM2 COMS™. CoM6™ COMS™ COM6™
PS5000 (Slim Panel Type 4 4 4
Core i3 Model) *> *6 COM1, COM2 COM2 COM2
PS5000 (Slim Panel Type
Atom Model) coMm1, com2™7 com2™7 com2™?
*5 %6
PSSOQ% (Enclosed Panel COMI ) i
Type)
PS5000 (Modular Type
PFXPU/PFXPP)"> "0 o 7 .
PS5000 (Modular Type CoMI COM1 COM1
PFXPL2B5-6)
PS5000 (Modular Type COM1, coM2™7 coma* com2*’

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Setup the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4  Setup the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.
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*S  When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.

When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6  To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

Settings FAQ ID
PFXZPBMPR42P2, RS422/485 change method FA263858
PFXZPBMPRA42P2 termination resistor setting FA263974
PFXZPBMPR44P2, RS422/485 change method FA264087
PFXZPBMPR44P2 termination resistor setting FA264088

*7  Setup the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8  For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PEXZPSCNM122.

DIP Switch settings (PL3000 / PS3000 Series)

RS-232C
DIP Switch Setting Description
1 OFF"! Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

(@) |

GP-Pro EX Device/PLC Connection Manual



SIMATIC S7 3964(R)/RK512 Driver

RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

#* Welcome to GP-Pro EX B3
4 Device/PLC
» evice,
GP-Prole ! |

Mumber of Devices/PLCs |1 3: ‘g
Device/PLC 1

Manufacturer | Siemens AG |L

Series SIMATIC 57 3964(R)/RKE12 E

Fart COM1 [+
Eefer to the manual of this Device/PLC
Eecent Device/PLC

A ¥

I Use Spstem Area Drevice Information

Back [B] | Communication Settings Mew Logic | Mew Screen I Cancel

Setup Items Setup Description

Number of Devi . . .
umber of Devices/ Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

PLCs

Manufacturer Select the manufacturer of the External Device to connect. Select "Siemens AG".
Select the External Device model (series) and the connection method. Select "SIMATIC S7
3964(R)/RK512".

Series In System configuration, make sure the External Device you are connecting is supported by
"SIMATIC S7 3964(R)/RK512".

& System Configuration" (page 3)
Port Select the Display port to connect to the External Device.

Check this option to synchronize the system data area of the Display and the device (memory)
of the External Device. When synchronized, you can use the External Device’s ladder program
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area]

Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"

Use System Area

~|
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3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are

shown.

3.1 Setting Example 1
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC T |
Surnmary Change Device/FLC
M anufacturer |Siemens AG Series SIMATIC 57 3964[R/RK512 Part  |COR1
Text Data Mode IT LChange

Communication Settings

510 Type « R5232C f_" " R5422/485(4wire)
Speed ’m

Data Length T {+

Parity " MOME f+ EVEN " opD

Stop Bit = 1 2

Flaws Control " MOME &+ ERIDTR/CTS] .

Timeout m [zec)

Retry m

Wait To Send [0 =ims

Rl /WCC « Rl " WEC

In the case of RS232C, you can zelect the Sth pin ta R [Input]
or Y¥CC [3% Power Supply). If you use the Digital's RS232C

|zolation Unit, pleaze select it to WCLC. Default

Device-5pecific Settingz

Allowable Mumber Add Device
of Devices/PLCs 1
Add Indirect
Mo, Device Mame Settings Device

1 [PLct ] [Block Check (BCCIO Device Mames=English (17071

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ -

,_i'f: Individual Device Settings

PLCY

W Black Check [BLCC)
Device Mame: @ English (IM3/MATAT/OB] © Gemnan [E AWM AT /Z/0E]

Default
okl | caneel |
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B Settings of External Device

(1) Startup "SIMATIC Manager" and create the new project. Set the optional project name and click [OK]. New

project is created.

(2) From the menu bar, select [Insert], [Station], [Name of CPU type to use] (ex: [1 SIMATIC 400 Station]) in this

order.

(3) [(Name of CPU type to use)] (ex: [SIMATIC 400 (1)]) is created in the project. Double-click [Hardware] of
the name of CPU type to use.

(4) When the [HW Config] screen displayed, open [(Name of CPU type to use)], [(RACK type to use)] (ex:
[SIMATIC 400], [RACK-400]) in this order from the left tree and select the base unit of the using model.

(5) Drag & drop the selected base unit to the upper right window. The rack figure is created in the window.
(6) Drag & drop the using power unit in the rack.
(7) Similarly, drag & drop the using CPU unit.

(8) When using CPUxxx-xDP, the [Properties - PROFIBUS interface DP] dialog box is displayed. In that case,
click [Cancel] and close the dialog box.

(9) Similarly, drag & drop the using link unit.
(10)Double-click the CPU unit dropped in the rack.
(11)When the [MPI port] setting dialog box is displayed, click [Properties].

(12)Click [Properties] as "MPI(1) 187.5 Kbps" is selected as default. The value entered in [Address] this time
becomes the Destination Node No. (PLC Address) you set in GP-Pro EX. The default is "2".

(13)To change the speed [Transmission rate] and the highest value of the node No. [Highest MPI address], click
the [Network Settings] tab.
Select [187.5Kbps] for [ Transmission rate]. To change the highest value of the node No. (Highest MPI

address), check [Change] to allow you to select from the list.
(14)When you finish setting, click [OK] and close the dialog box.

(15)Close other dialog boxes similarly.
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(16)Select [(Name of CPU type to use)] in the project, and open [Blocks] in the program, then double-click

[OB1].

(17)Here, you need to arrange the ladder program. Sample ladder program is shown below.

EN_F.
B
LADTR
LE_NO
DBB_NO
L_TYF
L_M0o

MDE.
ERROR
LEN
STATUS

CALL ™P_RCV_REK"

L_0FFZET:
L_CF_EYT:
L_CF_BIT:

, DET
: =TRUE
r=FALSE

t=2356

(18)Next, double-click [Hardware] in the CPU.

(19)Double-click the link unit as the link unit to use is already registered by the previous operation.

(20)To enable the communication between the External Device and the Display, click the [Parameter] button.

(21)The Parameter window is displayed. Select [RK512] from the [Protocol] list box and double-click the

[Protocol] image in the window.

(22)When the [Protocol] dialog box is displayed, set in the [RK 512] tab as below.

Setup Items Setup Description
With Block Check Check
Use Default Values Check
Transmission Rate 9600 bps
Stop Bits 1
Parity Even
Priority Low

(23)When you finish setting, click [OK] and close the dialog box.
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3.2 Setting Example 2
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |

Surmmary Change Device/PLC
t anufacturer |Siemens AG Sernies SIMATIC 57 3964[R)/RKS12 Port  |COR1
Text Data Mode 1 Change

Communication Settings

510 Type " RS232C - * R5422/4854wire)
Speed m

[rata Length 4 =

Parity " NOME f* EVEM ]

Stop Bit LONN| 2

Flows Control " MOME f* ERIDTR/CTS] o

Timeout 3 H [sec)

Fietmy m

wait To Send 0 2 [mz]

Rl AWCC = o

Inthe case of BS232C, you can select the Stk pin to Bl [Input]
or WEC [5Y Power Supply). If you use the Digital's BS232C

|zolation Unit, pleasze select it to WL Default

Device-Specific Settingz

Allowable Mumber Add Device
of Devices/PLCs 1
Add Indirect
Mo, Device Mame Settings Device

1 [PLca [i] [Block Check [BCCI=0N Device Names=Engish (/271

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

.i‘_‘: Individual Device Settings

PLCA

v Black Check (BCC)
Device Mames ' English (I/Q/M/T/C/DB] ¢ Geman [E/4/M /T /Z/0DB)

Defaulk
ok | caneel |
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B Settings of External Device

(1) Startup "SIMATIC Manager" and create the new project. Set the optional project name and click [OK]. New

project is created.
(2) From the menu bar, select [Insert], [Station], [(Name of CPU type to use)] in this order.

(3) [(Name of CPU type to use)] is created in the project. Double-click [Hardware] of the name of CPU type to

use.

(4) When the [HW Config] screen displayed, open [(Name of CPU type to use)], [(RACK type to use)] in this

order from the left tree and select the base unit of the using model.
(5) Drag & drop the selected base unit to the upper right window. The rack figure is created in the window.
(6) Drag & drop the using power unit in the rack.
(7) Similarly, drag & drop the using CPU unit.

(8) When using CPUxxx-xDP, the [Properties - PROFIBUS interface DP] dialog box is displayed. In that case,

click [Cancel] and close the dialog box.
(9) Similarly, drag & drop the using link unit.
(10)Double-click the CPU unit dropped in the rack.
(11)When the [MPI port] setting dialog box is displayed, click [Properties].

(12)Click [Properties] as "MPI(1) 187.5 Kbps" is selected as default. The value entered in [Address] this time
becomes the Destination Node No. (PLC Address) you set in GP-Pro EX. The default is "2".

(13)To change the speed [Transmission rate] and the highest value of the node No. [Highest MPI address], click
the [Network Settings] tab.
Select [187.5Kbps] for [ Transmission rate]. To change the highest value of the node No. (Highest MPI

address), check [Change] to allow you to select from the list.
(14)When you finish setting, click [OK] and close the dialog box.

(15)Close other dialog boxes similarly.

GP-Pro EX Device/PLC Connection Manual 12
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(16)Select [(Name of CPU type to use)] in the project, and open [Blocks] in the program, then double-click
[OB1].

(17)Here, you need to arrange the ladder program. Sample ladder program is shown below.

CALL ™P_RCV_REK"
EN F :=TRIE
B ¢ =FALSE
LADDE,  :=256
LE_NO
DEE_ND
L_TYP
L_M0o
L_0FFZET:
L_CF_EYT:
L_CF_BIT:
DR
EFRIR
LEN
STATUS

DET

i

(18)Next, double-click [Hardware] in the CPU.
(19)Double-click the link unit as the link unit to use is already registered by the previous operation.
(20)To enable the communication between the External Device and the Display, click the [Parameter] button.

(21)The Parameter window is displayed. Select [RK512] from the [Protocol] list box and double-click the

[Protocol] image in the window.

(22)When the [Protocol] dialog box is displayed, set in the [RK 512] tab as below.

Setup Items Setup Description
With Block Check Check
Use Default Values Check
Transmission Rate 9600 bps
Stop Bits 1
Parity Even
Priority Low

(23)When connecting CP341/CP441 with RS422/485, double-click the [Interface] tab and select [None] in [Initial

State of the Receive Line].

(24)When you finish setting, click [OK] and close the dialog box.

GP-Pro EX Device/PLC Connection Manual 13
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3.3 Setting Example 3
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC T |
Surnmary Change Device/FLC
M anufacturer |Siemens AG Series SIMATIC 57 3964[R/RK512 Part  |COR1
Text Data Mode IT LChange

Communication Settings

510 Type « R5232C f_" " R5422/485(4wire)
Speed ’m

Data Length T {+

Parity " MOME f+ EVEN " opD

Stop Bit = 1 2

Flaws Control " MOME &+ ERIDTR/CTS] .

Timeout m [zec)

Retry m

Wait To Send 0 2 [mz]

Rl /WCC « Rl " WEC

In the case of RS232C, you can zelect the Sth pin ta R [Input]
or Y¥CC [3% Power Supply). If you use the Digital's RS232C

|zolation Unit, pleaze select it to WCLC. Default

Device-5pecific Settingz

Allowable Mumber Add Device
of Devices/PLCs 1
Add Indirect
Mo, Device Mame Settings Device

1 [PLct ] [Block Check (BCCIO Device Mames=English (17071

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ -

.i‘_‘: Individual Device Settings

PLCA

W Black Check [BLCC)
Device Names @ English (I/Q/M/T/C/DB]  © Geman [EA4/M/T/Z/DB)

Defaulk
ok | caneel |
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B Settings of External Device
Use the ladder software (SIMATIC Manager STEP 7 S7/M7/C7) for communication settings of the External

Device.

Refer to your External Device manual for details.

(1) Start up the ladder software and create a new project.

(2) Set the hardware. Double-click [Hardware] from the [(Name of CPU type to use)] of the created project tree
view to display the [HW Config] window.

(3) Register the unit to be used.

(4) Double-click the Point-to-Point module to be used in the rack to display [Properties] dialog box.
(5) Select the slot number to be used from the [Interface] of the [Basic Parameters] tab.

(6) In the same way, select a module to be used from the [Module].

(7) Click the [Parameter] to display the [Assigning Parameters to Point-To-Point Connections] window.

NOTE | ¢ The [Parameter] is enabled after setting up the Protocol on the Point-to-Point module's attached
disk.

(8) Select [RK512] from the [Protocol].
(9) Double-click the mail icon to display [Protocol] dialog box.

(10) Set the setting items with [RK512] tab as follows.

Setup Items Setup Description
With Block Check Check
Use Default Values Check
Transmission Rate 9600 bps
Stop Bits 1
Parity Even
Priority Low
(11) Click [OK].

(12) Save the setting and close the window.

(13) Connect the module to be used for Point-to-Point network with the [General] tab.

(14) Close the [HW Config] window.

(15) Set a block. Select [Open] from the [File] menu to display the [Open Project] dialog box.
(16) Select "zXX21 03 PtP_Com_CP441" from the [Sample projects] tab.

(17) Click [OK].

(18) Select "CP441 RK512 Send/Recv" from the sample project tree view.

(19) Overwrite"S7 Program (1)" of created project with [Symbols] of "CP441 RK512 Send/Recv".

GP-Pro EX Device/PLC Connection Manual 15
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(20) In the same way, overwrite [Blocks] of the project created except for [System Data] from the [Blocks].
(21) Double-click [OB1] from the [Blocks] of created project tree view to display the [LAD/STL/FBD] window.
(22) Delete the line of "UC"SEND"//Call of FC for execution BSEND-Jobs" of Network 1.

(23) Save the setting and close the window.

(24) Set Network Configuration. Select [(CPU name in use)] from the created project.

(25) Double-click [Connections] in the project window to start up NetPro.

(26) Right-click the CPU to be used from the created project on NetPro.

(27) Select [Insert New Connection] to display the [Insert New Connection] dialog box.

(28) Select [Unspecified] from the created project of [Connection Partner] tree view.

(29) Select [Point-to-point connection] from the [Type] of [Connection].

(30) Click [OK] to display the [Properties -PtP connection] dialog box.

(31) Click [OK].

(32) Confirm that Point-to-Point connection is displayed in the [Local ID] as "1000".

(33) Select [Exit] from the [Network] menu to close the window.

(34) Download the hardware setting and Blocks setting to the Extended Device.

(35) Download the network configuration setting to the Extended Device.
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3.4 Setting Example 4
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |

Surmmary Change Device/PLC
t anufacturer |Siemens AG Sernies SIMATIC 57 3964[R)/RKS12 Port  |COR1
Text Data Mode 1 Change

Communication Settings

510 Type " RS232C - * R5422/4854wire)
Speed m

[rata Length 4 =

Parity " NOME f* EVEM ]

Stop Bit LONN| 2

Flows Control " MOME f* ERIDTR/CTS] o

Timeout 3 H [sec)

Fietmy m

wait To Send 0 2 [mz]

Rl AWCC = o

Inthe case of BS232C, you can select the Stk pin to Bl [Input]
or WEC [5Y Power Supply). If you use the Digital's BS232C

|zolation Unit, pleasze select it to WL Default

Device-Specific Settingz

Allowable Mumber Add Device
of Devices/PLCs 1
Add Indirect
Mo, Device Mame Settings Device

1 [PLca [i] [Block Check [BCCI=0N Device Names=Engish (/271

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

.i‘_‘: Individual Device Settings

PLCA

v Black Check (BCC)
Device Mames ' English (I/Q/M/T/C/DB] ¢ Geman [E/4/M /T /Z/0DB)

Defaulk
ok | caneel |
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B Settings of External Device
Use the ladder software (SIMATIC Manager STEP 7 S7/M7/C7) for communication settings of the External

Device.

Refer to your External Device manual for details.

(1) Start up the ladder software and create a new project.

(2) Set the hardware. Double-click [Hardware] from the [(Name of CPU type to use)] of the created project tree
view to display the [HW Config] window.

(3) Register the unit to be used.

(4) Double-click the Point-to-Point module to be used in the rack to display [Properties] dialog box.
(5) Select the slot number to be used from the [Interface] of the [Basic Parameters] tab.

(6) In the same way, select a module to be used from the [Module].

(7) Click the [Parameter] to display the [Assigning Parameters to Point-To-Point Connections] window.

NOTE | ¢ The [Parameter] is enabled after setting up the Protocol on the Point-to-Point module's attached
disk.

(8) Select [RK512] from the [Protocol].
(9) Double-click the mail icon to display [Protocol] dialog box.

(10) Set the setting items with [RK512] tab as follows.

Setup Items Setup Description
With Block Check Check
Use Default Values Check
Transmission Rate 9600 bps
Stop Bits 1
Parity Even
Priority Low
(11) Click [OK].

(12) Save the setting and close the window.

(13) Connect the module to be used for Point-to-Point network with the [General] tab.

(14) Close the [HW Config] window.

(15) Set a block. Select [Open] from the [File] menu to display the [Open Project] dialog box.
(16) Select "zXX21 03 PtP_Com_CP441" from the [Sample projects] tab.

(17) Click [OK].

(18) Select "CP441 RK512 Send/Recv" from the sample project tree view.

(19) Overwrite"S7 Program (1)" of created project with [Symbols] of "CP441 RK512 Send/Recv".
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(20) In the same way, overwrite [Blocks] of the project created except for [System Data] from the [Blocks].
(21) Double-click [OB1] from the [Blocks] of created project tree view to display the [LAD/STL/FBD] window.
(22) Delete the line of "UC"SEND"//Call of FC for execution BSEND-Jobs" of Network 1.

(23) Save the setting and close the window.

(24) Set Network Configuration. Select [(CPU name in use)] from the created project.

(25) Double-click [Connections] in the project window to start up NetPro.

(26) Right-click the CPU to be used from the created project on NetPro.

(27) Select [Insert New Connection] to display the [Insert New Connection] dialog box.

(28) Select [Unspecified] from the created project of [Connection Partner] tree view.

(29) Select [Point-to-point connection] from the [Type] of [Connection].

(30) Click [OK] to display the [Properties -PtP connection] dialog box.

(31) Click [OK].

(32) Confirm that Point-to-Point connection is displayed in the [Local ID] as "1000".

(33) Select [Exit] from the [Network] menu to close the window.

(34) Download the hardware setting and Blocks setting to the Extended Device.

(35) Download the network configuration setting to the Extended Device.
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

F g Example of Communication Setting" (page 8)

4.1 Setup Items in GP-Pro EX

B Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC1 |

Sumrnarng Change Device/PLC
I anufacturer |Siemens LG Series SIMATIC 57 3964 (R )/RES1 2 Part  |CORM1
Text Duata Mode 1 Change

Communication Settings

510 Type + RS232C A " RS5422/4B5(dwire]
Speed m

Data Length o O

Parity " NOME o EWEM " oDD

Stop Bit (Ol | 2

Flovs Control " NONE + ER[DTR/CTS] A

Timeout m [zec]

Retry m

Wait To Send [0 =limg

Rl /WCC &+ Rl " WCC

In the case of RS232C, you can select the Sth pin to Rl [Input)
or YCC [5Y Power Supply]. If you uze the Digital's R5232C

lzalation Unit, please select it ta WCC, Drefault

D evice-Specific Settingz

Allowable Mumber Add Device
of Devices/PLCs 1
Add Indirect
Mo, Device Mame Settings Device

1 [P ] [Block Check (BCCI=ON Device Names=Engish (1701

Setup Items Setup Description
SIO Type Select the SIO type to communicate with the External Device.
Speed Select speed between the External Device and the Display.
Data Length Select data length.
Parity Select how to check parity.
Stop Bit Select stop bit length.

Select the communication control method to prevent overflow of transmission and

Flow Control .
reception data.

Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the

Timeout .
response from the External Device.

continued to next page
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Setup ltems Setup Description

Retry

many times the Display retransmits the command.

In case of no response from the External Device, use an integer from 0 to 255 to enter how

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

Wait To Send "
packets to transmitting next commands.
Switch the 9th pin setting when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.

Please refer to the manual of the IPC for more detail.

NOTE | * Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf.  GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect

Device)"

W Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

,j_if: Individual Device Settings

Device Mames ¢ English [I/G/M/T/C/DB] ) Geman [EA8M/T/Z/0E]

Drefault |
oKim | Cancel |

Setup ltems

Setup Description

Block Check (BCC)

Check to enable the check sum.

Device Names

Select whether the device name is described in English (I/Q/M/T/C/DB) or German (E/A/
M/T/Z/DB).
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4.2 Setup Items in Offline Mode

NOTE | * Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode or

about the operation.

Cf.  Maintenance/Troubleshooting Guide "Offline Mode"

* The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in the offline mode. Touch

the External Device you want to set from the displayed list, and touch [Communication Settings].

| Gomm. Device Option
SIMATIC ST 5964(R)/RK512 [COM1] Page 1/1
SI0 Type R52320 £
Speed 960 B
Data Length ]
Parity NONE + EVEN 00D
Stop Bit o | 4
Flow Control {ER(DTR/CTS) [
Timeout(s) 3w A
Retry P w | a
Wait To Send(ms) 0l w| a
; 2005/09/02
| Gl Pook 13:63:26
Setup ltems Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT
To make the communication settings correctly, confirm the serial interface specifications of Display
SI0 Type .
unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does not support
is specified.
For details concerning the serial interface specifications, refer to the manual for Display unit.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and reception data.
Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the response from

the External Device.
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Setup ltems Setup Description

In case of no response from the External Device, use an integer from 0 to 255 to enter how many

Retr . . .
y times the Display retransmits the command.

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving packets to

Wait To Send .
transmitting next commands.

W Device Setting
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Device Settings].

Cormm, Device Option

SIMATIC ST 3964(R)/RKH12 [GOM1] Page 1/1
Device/PLC Name [PLCI ==
Block Gheck (BGG) Enable -
; 2PR5 /09,02
EAlY Bock 13:83:08
Setup Items Setup Description

Select the External Device for device setting. Device name is a title of External Device set

Device/PLC Name with GP-Pro EX.(Initial value [PLC1])

Block Check (BCC) Select [Enable] to enable the check sum.
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device
you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE * GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not
have the [Option] setting in the offline mode.
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5 Cable Diagram
The cable diagram shown below may be different from the cable diagram recommended by Siemens AG. Please
be assured there is no operational problem in applying the cable diagram shown in this manual.
* The FG pin of the main body of the External Device must be D-class grounded. Please refer to the manual of
the External Device for more details.
* SG and FG are connected inside the Display. When connecting SG to the External Device, design the system
not to form short-circuit loop.
* Connect the isolation unit, when communication is not stabilized under the influence of a noise etc..
Cable Diagram 1
Display
. Cable Remarks
(Connection Port)
GP3000 (COM1)
GP4000"! (COM1)
SP5000"% (COM1/2)
SP-5B00 (COM1) The cable length must be
ST (COMI) 1A User-created cable 15m or less.
LT3000 (COM1)
IPC™
PC/AT
GP-4105 (COM1)
GP-4115T (COM1) 1B User-created cable E‘;"jrbllzslse“gth must be
GP-4115T3 (COM1) :
LT-4*01TM (COM1) RJ45 RS-232C Cable (5m) by Pro-face
LT-Rear Module (COM1) | 1C PFXZLMCBRIR21 The cable length must be
Sm or less.
*1  All GP4000 models except GP-4100 Series and GP-4203T
*2  Except SP-5B00
*3  Only the COM port which can communicate by RS-232C can be used.

" m |IPC COM Port (page 4)

1A)

Display side
D-sub 9 pin (socket)

Signal

Pin name

Display SD(TXD

External Device side
D-sub 9 pin (socket)

Shield

Signal

Pin name

)
RD(RXD)

Y

RD(RXD)

ER(DTR)
DR(DSR)

SG

SD(TXD)

ER(DTR)

DR(DSR)

RS(RTS)

O IN|J]OaO|lo |~ N ]|®

CS(CTS)

t

SG

.- 4

RS(RTS)

e
-’
~

v | | v ]

O INjJ]OaO|loo |~ ]N

CS(CTS)
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1B)
Display side External Device side
Terminal block Shield D-sub 9 pin (s?cket)
Signal name VA ) e N\ Pin ﬁégnqgl
Display SD(TXD) VA SN RPN [V
RD(RXD) < :' ,' " 3 |spxp)
ER(DTR) : : : E 4 |ER(DTR)
DR(DSR) | ‘. i 6 [DROSR)
sG 5 sG
RS(RTS) “\\ I,"' 7 |RS(RTS)
CS(CTS) ﬂ Noemeea ‘ i E s |cs(cTs)
1C)
External Device side
D-sub 9 pin (socket)
Pn_ | Serd
Display TXD 2 RD(RXD)
RXD 3 SD(TXD)
(1) 4 ER(DTR)
E 6 |DR(DSR)
GND 5 SG
7 |RS(RTS)
E 8 |cs(cTs)
Legend Name Notes

(1

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21
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Display
(Connection Port)

Cable

Remarks

GP3000"! (COM1)
AGP-3302B (COM2)
GP4000"2 (COM2)
GP-4201T (COM1)
GP-4*01TM (COM1)

Arrange the cable length as
below according to the
speed.

GP-Rea£3M0dule (COM1) | 2A User-created cable 19200 or less: 1000m or less
SP5000 ° (COM1/2)
38400 : 500m or less
SP-3B00 (COM2) 115200 : 200m or less
ST™ (COM2) :
LT3000 (COM1)
IPC"
Arrange the cable length as
Online adapter by Pro-face below according to the
6 CA4-ADPONL-01 speed.
GP3000°" (COM2) 2B + 19200 or less: 1000m or less
User-created cable 38400 : 500m or less
115200 : 200m or less
Arrange the cable length as
below according to the
GP-4106 (COM1) speed.
GP-4116T (COM1) 2¢ User-created cable 19200 or less: 1000m or less
38400 : 500m or less
115200 : 200m or less
Arrange the cable length as
below according to the
PE-4000B"7 speed.
PS5000*7 2D User-created cable 19200 or less: 1000m or less

38400 : 500m or less
115200 : 200m or less

*1  All GP3000 models except AGP-3302B

*2  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*3  Except SP-5B00

*4  All ST models except AST-3211A and AST-3302B
*5  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000)

& m IPC COM Port (page 4)

*6  All GP3000 models except GP-3200 series and AGP-3302B

*7  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
‘5" m |PC COM Port (page 4)
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Display side External Device side
D-sub 9 pin (socket) Shield D-sub 15 pin (plug)
. Signal ! x : Signal
Pin na?ne ," A / “\‘ Pin na?ne
< i ] \
g 1 RDA [+— — 9 | TX(B)
2 | RDB 4—.—/: \c—-—: : 2 | XA
/ 3 | spa A+ 11 [Rx@) %
Termination| 7 SDB —H: W 4 RX(A)
resistance \ v
3300 5 SG ; — 8 | aND
6 CSB \ \o— SHIELD| Termination
j \ v resistance
9 ERB 330Q
8 CSA j
4 ERA

NOTE | * We recommend that the termination resistance should be attached when using the cable in 50m or

more length.

2B)

Display

External Device side

D-sub 9 pin (plug) jmmmmm-=- » D-sub 15 pin (plug)
: Signal ! A ; Signal
CA4-ADPONL-01 | — | name Poad "\ 0| name
g 2 | RDA e /\: : 9 | T™X(®B)
h 1
/ 7 | RDB |« s 2 | T™X(A)
3 | sbA ——» 11 | RX(B) %
)
Termination 8 SDB —'g—/ \—'g—,'—y 4 RX(A)
resistance \ Vo
3300 5 SG v — 8 GND
\ v L
N ¥ SHIELD Esrgmggn
3300

A
A

User-created cable

NOTE | * We recommend that the termination resistance should be attached when using the cable in 50m or

more length.
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2C)
Display side _ External Deyice side
Terminal block Shield D-sub 15 pin (plug)
Signal name / ',’ \ Pin ﬁ;@mg'
LA
< \—7 9 TX(B
. g RDA :, ] l‘. (B)
Display RDB 4—.—" ; ; 2 TX(A)
/ SDA A—+— 11 | Rx® %
Termination \ / U Ly 4 RX(A
resistance*1 SbB \ " ',' (A)
SG '\‘ 7 8 GND
\ \— SHIELD| Termination
SE j R - resistance
ERB 3300
CSA j
ERA

NOTE | * We recommend that the termination resistance should be attached when using the cable in 50m or
more length.

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 OFF
2D)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 15 pin (plug)
- bttty A - -
ol I A S N I
3 | Rer fe—— A1 % 9 | ™x@®)
. % AVEE!
Display 4 Rx- T 4 + 2 TX(A)
! A S
. / 2 Tx+ : 7 :. .: > 1 RX(B) %
Termination 1 Tx- ! W 4 RX(A)
resistance \ Voo
330 Q 5 GND + “ I' 8 GND
6 NC \ \—— SHIELD| Termination
R v resistance
9 NC 330Q
8 NC
7 NC

NOTE | * We recommend that the termination resistance should be attached when using the cable in 50m or
more length.
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of

the devices varies depending on the External Device to be used. Please check the actual range in the manual of

your External Device.

[===) This address can be specified as system data area.

Bit Address Word Address 32
Device . Remarks
English German English German bits
Data Block DB001.DBX000.0 - DB001.DBWO000 - 2y "1
DB255.DBX511.7 DB255.DBW510 =£]
Input 1000.0 - 1127.7 | E000.0-E127.7 | IW000-IW126 | EWO000-EW126 =27
Output Q000.0 - Q127.7 | A000.0-A127.7 | QW000 - QW126 | AW000 - AW126 HIL =27
=L "
Internal Marker MO000.0 - M255.7 MWO000 - MW254 =2 2
Timer | T000 - T255 B
Counter | C000 - C255 7000 - 7255 *2

*1  When you write the bit address, the Display reads the word address corresponding to that of the External Device
first. Change only the target bit address among the word data once read, and write the word data to the External

Device.
Note that the correct data may not be written if you change the word address value in the ladder program while

the Display reads the data of the External Device and writes it to the External Device.

*2  Write disable

NOTE | ¢ Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
* Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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7 Device Code and Address Code
Use device code and address code when you select "Device Type & Address" for the address type in data displays.
Word Address Device Code
Device v Address Code
English German (HEX)
(Data Block No. x 0x10000) + Value
Data Block bB DB 0000 of (word address divided by 2)
Input I E 0080 Value of word address divided by 2
Output Q A 0081 Value of word address divided by 2
Internal Marker M M 0082 Value of word address divided by 2
Timer T T 0060 Word Address
Counter C Z 0061 Word Address
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8 Error Messages

Error messages are displayed on the Display screen as follows: "No.: Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem

Description

No.

Error No.

Device Name

Name of the External Device where error occurs. Device name is a title of the External
Device set with GP-Pro EX. (Initial value [PLC1])

Error Message

Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of the External Device where error occurs, or error
codes received from the External Device.

» IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
» Device address is diplayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal[Hex]".

Display Examples of Error Messages
"RHAAQ035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE | * Refer to your External Device manual for details on received error codes.

« Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error

messages common to the driver.
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